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Artifact Rationale
Per the Veteran-focused Integrated Process (VIP) Guide, the User’s Guide is required to be completed prior to Critical Decision Point #2 (CD2), with the expectation that it will be updated as needed. A User Guide is a technical communication document intended to give assistance to people using a particular system, such as VistA end users. It is usually written by a technical writer, although it can also be written by programmers, product or project managers, or other technical staff. Most user guides contain both a written guide and the associated images. In the case of computer applications, it is usual to include screenshots of the human-machine interfaces, and hardware manuals often include clear, simplified diagrams. The language used is matched to the intended audience, with jargon kept to a minimum or explained thoroughly. The User Guide is a mandatory, build-level document, and should be updated to reflect the contents of the most recently deployed build. The sections documented herein are required if applicable to your product.
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[bookmark: _Toc155169219]Introduction
The Care Coordination (CC) Standardized Episodes of Care (SEOC) is a reference database for managing care bundles for use by Veterans Information Systems and Technology Architecture (VistA) and other Department of Veterans Affairs (VA) systems. Services are grouped together within the SEOC system into bundles so that clinicians can add these bundles to patients consult records in a standardized fashion, reducing the amount of time spent manually entering consult instructions, and providing uniformity among the patient records and across facilities for how patient care is prescribed for similar complaints.
These bundles group together one or more services that are preselected for different specialties to be added to the consult records. In addition, the clinician is provided with information regarding prescribing rules and preauthorization requirements, so they can make the most informed decisions regarding patient care.
Additionally, SEOC data will be accessible outside of the VistA/Computerized Patient Record System (CPRS) system so that users of downstream applications will be accessing the centralized data, and SEOC descriptions, reducing the chances of disconnects.
[bookmark: _Toc155169220]Purpose
The purpose of this document is to provide instruction for utilizing the SEOC application to standardize and streamline consult management for Community Care.
[bookmark: _Toc155169221]Document Orientation
The Care Coordination (CC) Standardized Episodes of Care (SEOC) v1.21 Database User Guide will provide explanations of each screen and of all user interface options within the context of an easy-to-understand demonstration data scenario. 
This document is also designed to provide the user with screen-by-screen “how to” information on the usage of CC SEOC.
[bookmark: _Toc155169222]Organization of the Manual
[bookmark: _Hlk508808487]Section 1: Introduction
The Introduction section provides the purpose of this manual, an overview of the SEOC software, an overview of the software used, project references, contact information for the user to seek additional information, and an acronyms and abbreviations list for this manual.
Section 2: System Summary
The System Summary section provides a graphical representation of the equipment, communication, and networks used by the system, user access levels, how the software will be accessed, and contingencies and alternative modes of operation.
Section 3: Getting Started
Information for the Getting Started section provides a general walk-through of the system from initiation through exit, enabling the user to understand the sequence and flow of the system.
Section 4: Using the Software
This section gives the user the “how to” information to use SEOC, including many step-by-step procedures.
Section 5: Troubleshooting
This section provides troubleshooting for the SEOC user.
Section 6: Acronyms and Abbreviations
This section provides a list of acronyms and abbreviations found in this document.
[bookmark: _Toc155169223]Assumptions
This guide was written with the following assumed experience/skills of the audience:
The SEOC user has been assigned the user role of SEOC Analyst. The SEOC Analyst can view Active or Discontinued SEOCs on the Home Page. These users can View, Print, or Track Version Changes on selected SEOCs. 
User has Google Chrome and/or Microsoft Edge installed on their machine.
The SEOC user has basic knowledge of the SEOC system (such as the use of commands, menu options, and navigation tools).
The SEOC user has been provided the appropriate active roles, menus, and security keys required for the SEOC User Interface (UI). 
The SEOC user is using SEOC to perform their daily consult creation workflow and perform the required SEOC functions.
The SEOC user has validated access to the SEOC UI.
The SEOC user has been provided training on the SEOC UI and has reviewed the User Guide.
SEOC Content Authors: The SEOC Content Authors are responsible for creating and update the content within the SEOC repository using the SEOC UI. These users are required to VA access rights and privileges and will sign on to the SEOC application using their Single Sign-On Integration (SSOI) credentials (typically their Personal Identification Verification (PIV) and access code).
CPRS Clinicians that are responsible for documenting patient consult records. These clinicians utilize the SEOC content as part of their daily consult creation workflow such that they will add a SEOC bundle to the patient consult record which will provide for a standardized documentation and care plan approach across the VA for these consults.
[bookmark: _Toc155169224]Coordination
One Consult - Consult Toolbox 1.9.02 and above and the HealthShare Referral Manager (HSRM) depend on the availability of the SEOC System. Consult Toolbox 1.9.02 requires active SEOCs whereas HSRM requires active and discontinued SEOCs. Coordination between the One Consult – Consult Toolbox, HSRM, and SEOC team is necessary with any updates to SEOC. 
[bookmark: _Toc155169225]Disclaimers
[bookmark: _Toc155169226]Software Disclaimer
This software was developed at the Department of Veterans Affairs (VA) by employees of the Federal Government in the course of their official duties. Pursuant to title 17 Section 105 of the United States Code this software is not subject to copyright protection and is in the public domain. VA assumes no responsibility whatsoever for its use by other parties, and makes no guarantees, expressed or implied, about its quality, reliability, or any other characteristic. We would appreciate acknowledgement if the software is used. This software can be redistributed and/or modified freely provided that any derivative works bear some notice that they are derived from it, and any modified versions bear some notice that they have been modified.
[bookmark: _Toc155169227]Documentation Disclaimer
The appearance of external hyperlink references in this manual does not constitute endorsement by the Department of Veterans Affairs (VA) of this Web site or the information, products, or services contained therein. The VA does not exercise any editorial control over the information you may find at these locations. Such links are provided and are consistent with the stated purpose of the VA.


[bookmark: _Toc155169228]Documentation Conventions
This manual uses several methods to highlight different aspects of the material.
Table 1. Documentation Symbols and Descriptions
	[bookmark: _Hlk134098401]Symbol
	Description

	[image: ]
	CAUTION: Used to caution the reader to take special notice of critical information.


[bookmark: ColumnTitle_02]Notes are used to inform the reader of general information including references to additional reading material.
[bookmark: _Toc155169229]References and Resources
[bookmark: _Toc408993568][bookmark: _Toc408996936][bookmark: _Toc408996969][bookmark: _Toc408999049]Readers who wish to learn more about CPRS and CC SEOC should consult the VA Software Document Library.
[bookmark: _Toc155169230]National Service Desk and Organizational Contacts
For issues related to the CC SEOC that cannot be resolved by this manual or the site administrator, please contact the National Service Desk.
[bookmark: _Toc155169231]System Summary
There was an immediate need to provide clinicians the ability to quickly and consistently add care bundles to a patient’s consult record within VistA. SEOC provides this feature for a higher level of uniformity in patient care, easier access to appropriate services, based on initial diagnoses, and the ability to better control care costs. SEOC allows clinicians to enhance the coordination of care for the Veteran.
The system contains SEOCs, or care bundles, that clinicians or other designated individuals can assign to VA patients. These bundles allow for the consistent use of procedures when certain conditions are diagnosed. This consistency allows the VA to effectively manage patient care and provides easier traceability.
[bookmark: _Toc155169232]System Configuration
The SEOC System is designed to be a simple reference database with a supporting SEOC Application Program Interface (API) and UI layer. The SEOC system comprises three application tiers as shown below.
[bookmark: _Ref500326578][bookmark: _Toc512420962][bookmark: _Toc153958501]Figure 1: Overview of SEOC System
[image: ]
The first tier is the Data Tier. This tier contains SEOC data. SEOC uses Microsoft Structured Query Language (SQL) Server is the database. SEOC data consists of reference data, such as SEOC name, associated procedures, associated Current Procedural Terminology (CPT) codes, procedure durations, etc. Additionally, user role information is maintained within the tables, but no passwords or other credentials are stored. No Protected Health Information (PHI) or Personally Identifiable Information (PII) is stored in the database. SEOC data is associated with patient data in the VistA consult record.
The second tier is the Abstraction Tier. This tier acts as the data broker for the SEOC system. It is a Representational State Transfer (REST) API, built as a microservice hosted on container infrastructure (Docker Container). The API itself is built on the Spring Model-View-Controller (MVC) framework. The API receives web API calls that are forwarded to the database appropriately. Consuming applications are able to query the SEOC system through the SEOC REST API but will not be able to perform updated operations. The SEOC UI uses certificates to authenticate with the SEOC REST API to allow data modification within the SEOC system by authenticated users. Users are authenticated using SSOI. Additionally, a VistA/MUMPS patch is created to insert the SEOC associations into File # 123.
The third and final tier is the Presentation Tier. This tier consists of the SEOC UI, which provides a user interface for approved, authenticated users to maintain the SEOC collection. This application is a web application built as a microservice hosted on container infrastructure (Docker Container). The UI is built using the React.js JavaScript framework for web applications. 
[bookmark: _Toc155169233]Data Flows
[bookmark: _Toc153958502]Figure 2: SEOC Data Flow Diagram
[image: ]
[bookmark: _Toc155169234]User Access Levels
SEOC user profiles comprise of the following “types of users”:
SEOC Content Authors: The SEOC Content Authors are responsible for creating and update the content within the SEOC repository using the SEOC UI. These users are required to VA access rights and privileges and will sign on to the SEOC application using their SSOI credentials (typically their PIV and access code).
CPRS Clinicians that are responsible for documenting patient consult records. These clinicians utilize the SEOC content as part of their daily consult creation workflow such that they will add a SEOC bundle to the patient consult record which will provide for a standardized documentation and care plan approach across the VA for these consults.
SEOC data is also accessible to other external consumers in the future (in addition to CPRS users). The SEOC API is a RESTFul API that other (to be determined) users will have access to use.
[bookmark: _Toc155169235]Continuity of Operation
The SEOC system is maintained by Enterprise Operations (EO). The continuity of operations is managed by EO. 
[bookmark: _Toc155169236]Getting Started
This section provides a general walkthrough of CC SEOC from initiation through exit. 
[bookmark: _Toc155169237]Logging On
CC SEOC is accessed using the VA SSOi log in. 
[bookmark: _Toc153958503]Figure 3: VA Single Sign-On for SEOC
[image: ]
After 15 minutes of inactivity the system will automatically log you out. After 13 minutes of inactivity the system will prompt you to extend your session.
[bookmark: _Toc153958504]Figure 4: 2 Minutes Until Session Expires Warning
[image: ]
[bookmark: _Toc155169238]System Menu
The Standardized Episodes of Care dashboard offers several features: Filter by Billing Code, Filter by Service Line, Filter by Status, Filter by Name, View Selected SEOCs, and Export SEOCs. The home page also displays the username and user role at the top right of the page.
[bookmark: _Toc153958505]Figure 5: Standardized Episodes of Care Dashboard
[image: Displays the Standardized Episodes of Care Dashboard which includes the Service Line, SEOC name, version nuver, effective date, end date, and status.]
	[bookmark: _Hlk134098402][image: Triangle with an exclamation point (!) inside to indicate caution for the reader to take special notice of critical information.]
	CAUTION: To view the list of SEOCs using a keyboard interface with assistive technology, you will need to use the “Tab” key to navigate through the list.




Standardized Episodes of Care table fields:
Service Line – A broad category of care for the services and procedures included which is intended to be used to group and filter SEOCs for easier accessibility. A standardized three-letter abbreviation of the service line is included at the beginning of the SEOC ID.
SEOC Name – A unique title that categorizes a SEOC by specialty/subspecialty or area of clinical practice.
Version – The version number of the SEOC. The version number is formatted A.B.C where the first digit will be 1, the second digit is the number of published SEOCs in the same Category of Care when a new SEOC is activated, and the third digit is a serialized revision number.
Effective Date –The date the SEOC status was made from In-Progress to Active.
End Date –The date the SEOC status was discontinued.
Status –The SEOC statuses are as follows: 
Active: When a SEOC is Active, it will be available for all end users (e.g. API users, scheduling, payment, and auditing purposes). 
Date Hold: When the SEOC status is Date Hold, it is pending and set for activation on a designated future date. This status is only available for SEOC Administrative users for editing purposes. 
Discontinued: When a SEOC is Discontinued, read-only users will not have access to the discontinued SEOC in the SEOC Database or the scheduling interface. However, the discontinued version will still be available for payment and auditing purposes. Discontinued SEOCs will remain in the SEOC database for up to six (6) years in the central repository.
In-Progress: The SEOC is available for editing purposes by the Administrators and Authors prior to activation. These SEOCs will not be available via SEOC Database API. 
[bookmark: _Toc155169239]Changing User ID and Password
If you need to change your user password, you will need to contact your local PIV office.
[bookmark: _Toc155169240]Exit System
If you are finished working, log out of VA Single Sign-On and close any secure sessions that may still be open by selecting the Logout button.


[bookmark: _Toc155169241]Using the Software
The CC SEOC provides user functionality for the following items: 
View Selected SEOC
View a Selected SEOC
Search for a SEOC by Name
Sort SEOCs Alphabetically by Name
Filter SEOCs by Status
Print a SEOC
Track Version Changes
Export SEOC
[bookmark: _Toc132807816]Export the SEOC Data to an Excel File
[bookmark: _Toc132807817]Export the SEOC Data to a JSON File
[bookmark: _Toc132807818]Export the VA PreCert Webpage Data to a JSON File
[bookmark: _Toc155169242]View SEOCs
[bookmark: _Toc155169243]View a Selected SEOC
To view a SEOC from the SEOC list, follow the steps listed below:
1. From the SEOC home page, select the SEOC you would like to view.
Select View Selected SEOC or tap the selected SEOC to view. The View SEOC page displays.
[bookmark: _Toc153958506]Figure 6: View SEOC (1 of 2)
[image: Displays an example of the View SEOC Page. Displays Effective Date, Category of Care, Revision, pre certification required, Q A S P, Description, Duration, and Procedural Overview information.]
[bookmark: _Toc153958507]Figure 7: View SEOC (2 of 2)
[image: Continuation of the View SEOC Page excample. Displays Additional Information, Provider Taxonomy Codes, and Payable Services information.]


[bookmark: _Toc155169244]View Filtered SEOCs
SEOC allows you to filter SEOCs by billing code, service line, status, and name. You also have the option to sort the displayed columns by selecting the arrow to the right of the column heading name.
[bookmark: _Toc117157023][bookmark: _Toc155169245]Filter SEOCs by Billing Code
To filter the list of SEOCs by billing code, follow the steps listed below:
Those with a Viewer role are unable to filter SEOCs by billing code.
1. From the SEOC Admin home page, enter the billing code in the Billing Code Filter field.
[bookmark: _Toc117157090][bookmark: _Toc153958508]Figure 8: Billing Code Filter Field
[image: Displays the Filter by Billing Code field.]
2. Select the Search button. The SEOC list refreshes to display the SEOCs list filtered by the billing code type.
[bookmark: _Toc117157091][bookmark: _Toc153958509]Figure 9: Billing Code Filter Search Results
[image: Displays the search results for the filter by billing code.]
[bookmark: _Toc117157024]

[bookmark: _Toc155169246]Filter SEOCs by Service Line
To filter the list of SEOCs by Service Line, follow the steps listed below:
1. From the SEOC Admin home page, select Filter by Service Line menu.
[bookmark: _Toc117157092][bookmark: _Toc153958510]Figure 10: by Service Line Filter Menu Options
[image: Displays the menu options for the Filter by Service Line drop-down menu.]
4. From the list of options, select one of the service line types to filter by. The SEOC list refreshes to display the SEOCs list filtered by the selected service line type.
[bookmark: _Toc155169247]Filter SEOCs by Status
To filter the list of SEOCs by status, follow the steps listed below:
1. From the SEOC home page, select Filter By Status menu.
[bookmark: _Toc153958511]Figure 11: Filter by Status Menu Options
[image: Displays the Filter by Status menu options. The options include: All, Active, Date Hold, and Discontinued.]
From the list of options select to filter by: All, Active, Date Hold, Discontinued, or In-Progress. The SEOC list refreshes to display the status filtered by.
[bookmark: _Toc16600022][bookmark: _Toc24637521][bookmark: _Toc61979176]

[bookmark: _Toc155169248]Filter SEOCs by Name
To filter the SEOCs by name, follow the steps listed below:
1. From the SEOC home page, enter the name of the SEOC in the Filter by Name (contains) field. 
[bookmark: _Toc153958512]Figure 12: Filter by Name Field
[image: Displays an example of the Filter by Name Field. The steps in this screen are defined below.]
Select the Search button. The Filter by Name Results display.
[bookmark: _Toc16600023][bookmark: _Toc24637522][bookmark: _Toc61979177][bookmark: _Toc153958513]Figure 13: Filter by Name Results
[image: Displays an example of the Filter by Name Results. ]
[bookmark: _Toc16865652]

[bookmark: _Toc155169249]Print a SEOC
To print a SEOC, follow the steps listed below:
1. From the SEOC home page, select the SEOC you would like to print.
Select View Selected SEOC or tap the selected SEOC to view, the View SEOC page displays.
Select Print SEOC. The printed SEOC will display in another window. Print or save using local browser capabilities.
[bookmark: _Toc153958514]Figure 14: Printed SEOC Window
[image: This screen displays the Standardized Episodes of Care in a print format.]
[bookmark: _Toc155169250]Track Version Changes
To track the version changes of a SEOC, follow the steps listed below:
1. From the SEOC home page, select a SEOC with a previous version.
Select View Selected SEOC or tap the selected SEOC to view, the View SEOC page displays.
Select the Track Version Changes button when it becomes active. The Track Version Changes page will display.
[bookmark: _Toc153958515][bookmark: _Toc16600014][bookmark: _Toc16865878]Figure 15: Track Version Changes Page
[image: Displays an example of the Track Version Changes Page. The steps in this screen are defined below.]
Select the Previous Version button. The changes for the previous version will be shown. If the previous version is the first version of this SEOC, no changes will be displayed.
Select the Next Version button. The changes for the next version will be shown.
Select the Print SEOC button. The Print SEOC page will display with the current changes.
[bookmark: _Toc16600017][bookmark: _Toc16865881][bookmark: _Toc153958516]Figure 16: Print SEOC from Track Version Changes Page
[image: This screen displays the Standardized Episodes of Care Additional Information track changes in print format. ]
By default, Internet Explorer 11 will not print the red and green background colors. To print the red and green background colors, check the Print Background Colors and Images box in the Page Setup dialog from the Print menu.
[bookmark: _Toc132803085][bookmark: _Toc155169251]Exporting Data
Those with a Viewer role are unable to export data.
[bookmark: _Toc143114855][bookmark: _Toc155169252]Export the SEOC Data to an Excel File
To export the SEOC Data, follow the steps listed below:
1. As an Analyst, Coder, Publisher, or Administrator on the SEOC Admin home page, select Export. The Export SEOC window displays with the Export SEOCs tab open by default.
[bookmark: _Toc143114988][bookmark: _Toc153958517]Figure 17: Export SEOC Window
[image: Displays the Export SEOC window. Window offers the Export SEOCs tab and the Export Precert Wedpage Data tab.]
10. Select Excel from the Export SEOCs section.
Excel exports have a limit of 1,048,576 rows by 16,384 columns. If you think you may exceed this, select JSON instead. The steps to export to a JSON file can be found in the Export the SEOC Data to a JSON File section.
11. Select which status options to include in the export and select Continue. The Export SEOC Data Properties display.
12. Select which properties to include in the export and select Export. The SEOC data will be exported to an Excel file that you will need to save.
If no SEOCs match the export criteria, the following message will display “No SEOCs found that match your export request, please select different options to export SEOCs.”.
[bookmark: _Toc143114856]

[bookmark: _Toc155169253]Export the SEOC Data to a JSON File
To export the SEOC Data, follow the steps listed below:
1. As an Analyst, Coder, Publisher, or Administrator on the SEOC Admin home page, select Export. The Export SEOC window displays with the Export SEOCs tab open by default.
[bookmark: _Toc143114989][bookmark: _Toc153958518]Figure 18: Export SEOC Window 
[image: Displays the Export SEOC window. Window offers the Export SEOCs tab and the Export Precert Wedpage Data tab.]
14. Select JSON from the Export SEOC Data section.
15. Select which status options to include in the export and select Continue. The SEOC data will be exported to a JSON file that you will need to save.
If no SEOCs match the export criteria, the following message will display “No SEOCs found that match your export request, please select different options to export SEOCs.”.
Please refer to Appendix A for additional steps on converting the JSON file into an Excel file.
[bookmark: _Toc16865672][bookmark: _Toc143114857]

[bookmark: _Toc155169254]Export the VA PreCert Webpage Data to a JSON File
For all users who can Export SEOC Data, the SEOC Admin UI also allows them to export the data required for the VA PreCert Webpage.
To export the SEOC PreCert Data, follow the steps listed below:
1. As an Analyst, Coder, Publisher, or Administrator on the SEOC Admin home page, select Export. The Export SEOC window displays with the Export SEOCs tab open by default.
[bookmark: _Toc143114990][bookmark: _Toc153958519]Figure 19: Export SEOC Window 
[image: Displays the Export SEOC window. Window offers the Export SEOCs tab and the Export Precert Wedpage Data tab.]
17. Select the Export VA Precert Webpage Data tab. 
[bookmark: _Toc143114991][bookmark: _Toc153958520]Figure 20: Export VA Precert Webpage Data Tab
[image: Displays the Export V A Precert Webpage Data Tab. ]
18. Select Export. The SEOC data will be exported to a JSON file that you will need to save.
[bookmark: _Toc143114992][bookmark: _Toc153958521]Figure 21: SEOC Export Completed Confirmation Message
[image: Displays the SEOC Export Completed Confirmation Message.]
19. Select OK. The SEOC data will be exported to a JSON file that you will need to save. 
Please refer to Appendix A for additional steps on converting the JSON file into an Excel file.
[bookmark: _Toc155169255]Troubleshooting
Users may encounter the following errors while using the SEOC UI. 
Table 2: SEOC Error Codes with Descriptions
	[bookmark: _Hlk134098403]Error Code
	Description

	204
	No Content Found

	401
	Unauthorized

	403
	Forbidden

	404
	Not Found




[bookmark: _Toc155169256]Acronyms and Abbreviations
	[bookmark: _Hlk508800414]Acronym
	Definition

	API
	Application Program Interface

	CC
	Care Coordination

	CCAD
	Community Care Agile Development

	CPRS
	Computerized Patient Record System

	CPT
	Current Procedural Terminology

	HSRM
	HealthShare Referral Manager

	EO
	Enterprise Operations

	JSON
	JavaScript Object Notification

	MVC
	Model-View-Controller

	NSD
	National Service Desk

	OIT
	Office of Information and Technology

	PHI
	Protected Health Information

	PII
	Personally Identifiable Information

	PIV
	Personal Identification Verification

	REST
	Representational State Transfer

	SEOC
	Standardized Episode of Care

	SQL
	Structured Query Language

	SSOI
	Single Sign-On Integration

	UI
	User Interface

	VA
	Department of Veterans Affairs

	VDL
	VA Software Document Library

	VIP
	Veteran-focused Integrated Process

	VistA
	Veterans Health Information Systems and Technology Architecture





[bookmark: _Toc133231084][bookmark: _Toc155169257]Appendix A: JSON Instructions
To convert the SEOC JSON file to an Excel file, follow the steps listed below:
1. Open a blank workbook in Excel.
Select the Data tab, then Get Data > From File > From JSON. The Import Data window displays.
[bookmark: _Toc133231226][bookmark: _Toc153958522]Figure 22: Import Data Window
[image: Import data window  is detailed in steps listed below.]
Select the JSON file you downloaded and select Import. Excel will open the file in the Query Editor.
[bookmark: _Toc133231227][bookmark: _Toc153958523]Figure 23: Query Editor
[image: Query editor  is detailed in steps listed below.]
Select the List header to the right of SEOCs to display a list of records.
[bookmark: _Toc133231228][bookmark: _Toc153958524]Figure 24: List of Records
[image: List of records displayed.]
From the Transform tab, select the Convert To Table icon and select OK. The To Table dialog box displays.
[bookmark: _Toc133231229][bookmark: _Toc153958525]Figure 25: To Table Dialog Box
[image: To table  is detailed in steps listed below.]
From the To Table dialog box keep the default selections and select OK.
[bookmark: _Hlk533765398]Select on the expand icon (<-||->) to the right of the Column1 header to display the Search Columns to Expand dialog box.
[bookmark: _Toc133231230][bookmark: _Toc153958526]Figure 26: Search Columns to Expand Dialog Box
[image: Search columns to expand dialog box  is detailed in steps listed below.]
De-select the Use original column name as prefix check box.
Select OK.
Select on the expand icon (<-||->) to the right of the SEOC header to display the Search Columns to Expand dialog box.
[bookmark: _Toc133231231][bookmark: _Toc153958527]Figure 27: Search Columns to Expand
[image: Search columns to expand  is detailed in steps listed below.]
Uncheck the Use original column name as prefix check box.
Select OK. The fields in the SEOC table will be expanded to columns as shown below.
[bookmark: _Toc133231232][bookmark: _Toc153958528]Figure 28: Expanded SEOC Fields
[image: Expanded SEOC fields  is detailed in steps listed below.]
Scroll right to the services column, select on the expand icon, and select Expand to New Rows to display the records.
[bookmark: _Toc133231233][bookmark: _Toc153958529]Figure 29: Expand to New Rows Menu Option
[image: Expand to new rows menu options  is detailed in steps listed below.]
Select the expand icon again and press OK to expand the Payable Services fields into columns.
[bookmark: _Toc133231234][bookmark: _Toc153958530]Figure 30: Payable Services Columns
[image: Payable services columns  is detailed in steps listed below.]
Scroll right to the billingCodes column and repeat the last two steps to expand the Billing Code fields into columns.
[bookmark: _Toc133231235][bookmark: _Toc153958531]Figure 31: Billing Code Columns
[image: Billing code columns  is detailed in steps listed below.]
Optional - Repeat the last two steps again for the serviceHptcs column if you want to see the cross-walked HPTCs that are sent for each Payable Service.
Scroll right and repeat the last two steps again for the hptcs column to expand the HPTC fields that were assigned to each SEOC. 
[bookmark: _Toc133231236][bookmark: _Toc153958532]Figure 32: Expanded HPTC Fields
[image: Expanded HPTC fields  is detailed in steps listed below.]
Select the Close & Load option at the left of the ribbon to create load the imported data into a spreadsheet tab.
[bookmark: _Toc133231237][bookmark: _Toc153958533]Figure 33: Imported Data
[image: Displays the imported data.]
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7 |1876 254 Cardiopulmonary Exercise Testing MSC_CARDIOPULMONARY EXERCISE TESTING_1.3.1 This authorization covers Cardiopulmonar 241,007 rows loaded.

8 |1876 254 Cardiopulmonary Exercise Testing. MSC_CARDIOPULMONARY EXERCISE TESTING_1.3.1 This authorization covers Cardiopulmonari
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12| 1888 128 Transient Center-Based Assisted Hemodialysis_PRCT DIA_TRANSIENT CENTER-BASED ASSISTED HEMODIALYSIS_1.5.6_PRCT This authorization covers services associat

13 | 1888 128 Transient Center-Based Assisted Hemodialysis_PRCT DIA_TRANSIENT CENTER-BASED ASSISTED HEMODIALYSIS_1.5.6_PRCT This authorization covers services associat
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191888 128 Transient Center-Based Assisted Hemodialysis_PRCT DIA_TRANSIENT CENTER-BASED ASSISTED HEMODIALYSIS_1.5.6_PRCT This authorization covers services associat
20| 1888 128 Transient Center-Based Assisted Hemodialysis_PRCT DIA_TRANSIENT CENTER-BASED ASSISTED HEMODIALYSIS_1.5.6_PRCT This authorization covers services associat
211953 158 Emergency Care_PRCT EUC_EMERGENCY CARE_1.2.3_PRCT This authorization covers services associat
221953 158 Emergency Care_PRCT EUC_EMERGENCY CARE_1.2.3_PRCT This authorization covers services associat
231953 158 Emergency Care_PRCT EUC_EMERGENCY CARE_1.2.3_PRCT This authorization covers services associat
241953 158 Emergency Care_PRCT EUC_EMERGENCY CARE_1.2.3_PRCT This authorization covers services associat
251953 158 Emergency Care_PRCT EUC_EMERGENCY CARE_1.2.3_PRCT This authorization covers services associat
261953 158 Emergency Care_PRCT EUC_EMERGENCY CARE_1.2.3_PRCT This authorization covers services associat
271953 158 Emergency Care_PRCT EUC_EMERGENCY CARE_1.2.3_PRCT This authorization covers services associat
281953 158 Emergency Care_PRCT EUC_EMERGENCY CARE_1.2.3_PRCT This authorization covers services associat
291953 158 Emergency Care_PRCT EUC_EMERGENCY CARE_1.2.3_PRCT This authorization covers services associat
301953 158 Emergency Care_PRCT EUC_EMERGENCY CARE_1.2.3_PRCT This authorization covers services associat
311953 158 Emergency Care_PRCT EUC_EMERGENCY CARE_1.2.3_PRCT This authorization covers services associat
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371953 158 Emergency Care_PRCT EUC_EMERGENCY CARE_1.2.3_PRCT This authorization covers services associat
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